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Abstrakt

Naplni této diplomové prace je vyhotoveni geodetick prostorové
dokumentace Useku Zlata stezka. Vybrany Usek dedmaa obce Strazny nedaleko
hranic se SRN.

V prvni ¢asti této prace je popsana historie Zlaté stezkgdgvSim pak
Vimperska ¥tev, pouzité geodetické metody a representace dgtografickych
informanich systémech. V této teoretickésti diplomové prace jsou mimo jiné
uvedeny druhy digitalnich modelterénu a skr dat pro jejich tvorbu. Posledni
kapitola je ¥novana popisu prograimkteré byly pouzity pro zpracovani diplomové
prace.

Druhacast diplomové prace sémnuje zpracovani samotnych vyslédide zde
popsan zfisob ziskani dat — geodetické zdiemi v terénu a jejich vyget. Dalsi
kapitola je ¥novana tvorb digitalnich modael terénu (model TIN a rastrovy model).
Vysledné DMT byly porovnany z hlediskagsnosti narrenych a ziskanych dat.

Posledni kapitola se zabyva moznymi vizualizaceMiTDy prostedi ArcScene.

Kli¢ova slova: Zlatd stezka, geodéziedigitalni model terénu, geografické
informacni systémy (GIS), GNSS, geostatistika



Abstract

The aim of this thesis is the original surveyingl aspatial documentation
section of the Golden Trail. The selected sect®iocated near the village guard

near the border with Germany.

In the first part of this thesis describes the dmstof the Golden Tralil,
especially Vimperk branch, used geodetic methodd data representation in
geographic information systems. In the theorefeat, inter alia, the types of digital
terrain models and data collection for their woflke last chapter is devoted to

describing the programs that were used for proeggsbe thesis.

The second part of the thesis deals with the psiegsof the results
themselves. There is described a method of obtautta - geodetic surveying in the
field and their calculation. Another chapter is oled to the creation of digital
terrain models (model TIN and grid model). The hasg DTM were compared in
terms of accuracy of the measured and the datanebtalhe last chapter deals with

possible visualization environment DTM in ArcScene

Key words: Gold Trail, Geodesy, Digital Terrain Model, Geaghical Inforamtion
System (GIS), GNSS, Geostatistic
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1 Uvod

Zlata stezka — kdysi po této stezce putovaly kamgwz tmeckého Pasova do
Cech, piivazejici s sebouit koreni, latky a jiné zbozCily obchodni ruch zde kvetl
prakticky cely stedowk az do ficetileté valky. Po nastupu Habsbiirka tfin
ziskala monopol rakouskélsa Zlata stezka upadla v zapotnn Nekteré jeji useky
se casem zmnily ve statnisilnice, jiné naopak #Aataly lesem a staly se
negistupnymi.Casto byvaly zbytky Zlaté stezky vyuzivany paseréltg,obchod se
uz zpatky nikdy nevratil. Po druhé &wové valce secést Zlaté stezky ocitla
v pohranéni zor¢, kam byl zakaz vstupu ¥gnosti. A mozna diky tomu se
dochovaly gkteré vyznamné fragmenty az do dnesni doby.

Od za&atku 90. let minulého stoleti byla postdpdlata stezka na nasem
Uzemi detailtji zkouména. Asi negtsi zasluhu na vyzkumu maji F. Kuka
P. Zavel, nebd se vyzkumu vSechritvétvi Zlaté stezky na naSem Uzenghwovali
témét 15 let. Diky jejich praci byly uUseky Zlaté stezkyejen archeologicky
prozkoumany, ale také geodeticky zdgiemy. V sodasné dob dokortuji prizkum
Zlaté stezky nagmeckém Uzemi.

Novym ginosem pro uchovani dat a presentaci vysledkZlaté stezce by
mohlo byt vyuZiti geografickych inforndaich systém (GIS). Redevsim 3D modely
Gzemi se zagtenymi Useky by vhodndophovaly tento rozsahly vyzkum aipliZzili

jej Sirsi verejnosti.



2 Cile prace

Hlavnim cilem diplomové prace bylo vyuzit geogriaéi informa&ni systémy
(GIS) ke zdokumentovani séasného stavu Useku Zlaté stezky v okoli obce Sprazn
s naslednou tvorbou digitalniho modelu terénu avBfalizace. VedlejSim cilem
bylo posouzeniigsnosti narenych vyskopisnych dat s vySkopisem dat ziskanych
od Ceského tadu zemiméiického a katastralnih@JZK).

Jednim z @voda, prat pouzit GIS p zdokumentovani Zlaté stezky, je jeho
vS8estrannost. Vysledky ziskané z dostupnythmowe ziskanych dat Ize snadno

spravovat a upravovat pro dalSi pouziti.
Cili diplomové prace bylo:
1) ziskat a upravit data pro vyuziti tvorby digitalmimodet terénu,
2) z dostupnych dat vyt digitalni modely terénuiznymi typy representace,
3) posouzeni fesnosti vyskopisu naffeného a vyskopisu ziskaného©dzK,
4) tvorba rozsahlejSiho modelu terénu a jeho vizuediza

5) vyhodnotit ginos vyuziti GIS.



3 Historie Zlaté stezky

Nazvy ,Zlata stezka“ a ,Zlata cesta“ ozio®aly od pdatku 16. stoletiit
staré komunikace, které vedly ZiMecka doCech a které j@krasovaly pohranini
hvozdy Sumavy & eského lesa. Prvni z nich vedla z NorimberkaspWeiden,
Tachov a Plz& do Prahy, druhd z Pasova a Vilshofentesp Grafenau do
KaSperskych Hor, SuSice a Klatov. Nejvice vSak jmgdlata stezka® utk¥lo na
systému obchodnich cest, které od ranéhedeitku spojovaly Pasov &skymi
zememi a po nichZ proudilaipdevsim 8l ze Solnohradska na sever (KulZawvel
2007). Jeji systém se postémozSioval a ve 14. stoleti jiz twidy stezku i hlavni
linie. Pobliz ceskych hranic v oblasti Freyungu a Waldkirchenuvgéenily tfi
zakladni trasy, a to kaSperskohorska, vimperskdaahpticka wtev (Kuna et al.
2004).

* Dolni Zlata stezka— nejstarSi a nejvyznarggi wtev, dolozena od gatku
11. stoleti. Spojovala Pasov s Prachaticerf@s pSalzweg, Strasskirchen,
Leoprechting, Kringell, Grossthansteig, Vendelsbergussernbrinst,
Deching, Ernsting, Oberleinbach, Schiefwegtipp Waldkirchen,
Bohmzwiesel, Firholz, Grainet, Leopoldsreut, Bidsteut, Ceské Zleby,
Volary, BlaZejovice, Albrechtovice a Libinské Se@ubu, Zawel 2007).

o Stiredni Zlata stezka— doloZena od p@tku 14. stoleti. Tatogev spojovala
Pasov s Vimperkem ips Ernsting, Wotzmannsreut, Reut, Winkelbrunn,
Hinterschmiding, Herzogsreut, Philippsreut, Strazmlibky, Havranku,
Horni Vltavici, Kubovu Hd, ArnoStku, Korkusovu H&1a Solnou Lhotu
(Kubu, zawel 2007).

e Horni Zlata stezka — vznikla v polovig 14. stoleti. Spojovala Pasov
s KaSperskymi Horami ips Salzgattern u Vendelsbergu, Ro&hrnbach,
Harsdorf, Freyung, Kreuzberg, Mauth, Finsterau¢iBu, Kvildu, Horskou
Kvildu, Zhaii aCervenou nebo Kozi ety (Kuli, Zawel 2007).

Existujerada nepimych doklad, Zze Sumavskérpchody byly vyuzivany jiz
v prawku (Bene$S 1995), ale prvni historické zprdvy o ramme z 11. stoleti.
Némecky kral Jinéich II. (pozdji fimsky cis#) daroval listinou z roku 1010
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pasovskému Zenskému klasteru Niedernburg mytnéagiypha cest do Cech a
nékdy na konci 11. stoletifpnechakesky vévoda Vratislav 1l. obdobné poplatky na
cest z Prachatic do Pasova VySehradské kapitul€. ddolarované cirkevni instituce
spravovaly stezku v prvnich stoletich jeji exiseeneunkci Niedernburgu jiz od 12.
stoleti postup® prebiralo pasovské biskupstvi a ®aské strakh vystidala po
husitskych vélkach vySehradskou kapitulué¢tskd moc, pedevSim vyznamny
jihocesky rod Rozmbertk(Prax! et al. 2011).

Hlavnim obchodnim artiklem na Zlaté stezce bylspoere sil. Ceské zera
ji m¢ly nedostatek a poptavka po ni byla &mavysoka (Stary 2002), nebdo byl
mj. i jediny konzervani prostedek na potraviny. i se dovazela ze solnych loZisek
ve vychodoalpské oblasti v Reichenhallu a Hallgiepravovala se ptece Inn do
Pasova a odtud natietech soumarskych koni po Zlaté stezes Sumavu d@ech.
(Praxl et al. 2011) Krognsoli se z Pasova doech vozily drahé latky, jizni plody,
kofeni a vino (Andreska 1994) a @épgm snérem hlavie obili a dale slad, med,
chmel, vina, kZe, pivo a dalSi potravibgké produkty (Pilat 1947).

Konec obchodu na Zlaté stezce je datovan ke kbncstoleti, jak se jiz o
tom zmiuje Teply (1948) ... ficetiletd valka zasadila i starym komunikacim od
Pasova daCech smrtelnou ranu. Brzy po vestfalském miru p@stav Linci fes
Dunaj velky most, VySebrodsti Cisterciacicpb mytit lesy mezi VysSim Brodem a
Leonfeldem, stara cesta timto hvozdem nejenom &stédu Sgtlé, ale i fes Linec
k Welsu pro valénou dilezitost dolbe spravena a tak soufnajinsi cestovnici od
jihu, zejména se soli od Haleinu, Solnohradu zvslbpomenutim veliké zajiky
pasovské kratSi a mé&mornatou silnici Linec — Krumlov — Bgpbvice a jiz kolem
roku 1672 — 1680, kdy v Bégvicich rozsfena stara solnice Salzhaus.”

Zlata stezka ijgdstavuje rozsahly archeologizovany prvek kultlarajiny,
ktery v mnohém fedznamenava rozvoj silimi si¢ v terezianském obdobi. Trasy
Zlaté stezky jsou antecedentefady dneSnich Sumavskych sdnich Usek. Se
Zlatou stezkou je spojen vznikady vyznamnych aredl dosud patrnych, nap
Volarskych Sanci nebo opesni u Kaenného. Pozoruhodny je i systém straznich
hradki, situovanych v blizkosti komunikace (Hradek nazstké skale, Kunzvart)
(Kuna et al. 2004).
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3.1 Vimperska vétev

Cesky nazev wfsta Vimperk je odvozeninou odiypodniho gmeckého nazvu
Winterberg (Zimni hora) iies mezitvary Wimberg a Vimberk, pouzivané §dstzné
v 19. stoleti. Nmecké mistni ndzvy, které obsahuji slovo Wintemé&i zimni),
signalizovaly obvykle severni polohu sidiistebo polohu, kde se dlouho drzel snih.
(Kubt 2005)

Vimperskd obchodni cesta je poprvé #owidna roku 1312. Je vSak
pravdpodobné, Ze to byla cesta mnohem starSi, jakédas)e hradis Vénec
z doby halStatské a laténské a jin4 hr&distidoli Volyiky. V polovirg 13. stoleti
postavil zvikovsky purkrabi Burghardt, sasnik HirZiv, na kralovském lénu hrad
Vimperk, remecky Winterberg, Zimni hora. Hrad st& pbchodni cest Fi jeho
Gpati vzniklo zahy stejnojmenné tr&Stkteré ziskalo roku 1479 dstskd prava.
Koncem 13. stoleti byl na této stezcé pranici Cech postaven strézni hrad
Konigswarte, odtud Kunzvart, nyni Strazny. Nsnecké stratt Sumavy byl na této
stezce okolo roku 1200 postaven hrad Wolfsteinghoh vznikla obec a pozj
meésto Freyung, ,svobodné &sto“ osvobozené od popldikpri kolonizaci. Tak
ziskala vimperska cesta hneil ochranné hrady, které dbaly o jeji besapast.
Vimpersky solny obchod nedosahoval objemu prackélic, ale i tak byl velice

vyznamny (Andreska 1994).

Solni obchod vynasel a logicky ®v nému dochazelo k mnoha spon.
Prachatice, nejvyznanyj$i ceské nésto na Zlaté stezce, hkdg na Vimperk jako na
svého nezadouciho konkurenta a snazilo se jejiggymi usgchy a neusgchy
v jeho podnikani omezit. Podle dohody z roku 15D8asimdi mohli vybrat, zda
svij naklad soli dopravi do Prachatic nebo do Vimpegkaikdo jim v tom nesih
branit. Vimpersti nili prdvo na uzivani Zlaté stezky zakotveno i vensv&stském
privilegiu krale Vladislava Jagellonského z rokuww@4Kuhi 2005).

Dovezena @ z Pasova ndstala ve Vimperku dlouho. Putovala odtud dale
do celého Pracliského a Bechyského kraje. Z roku 1592 se zachovalo ve Statnim
oblastnim archivu v ®boni v pobdce Cesky Krumlov gkolik zajimavych dopis,
které zasilal bechigky hejtman ik Homout z Harasova vimperskému hejtmanu.

13



V prvnim zachovaném, z uUnora 1592, Zzadal vimpeskdtejtmana Jakuba
Roudnického o odeslani 12 prostic soli, protoZelikyenedostatek strany soli na
obrasnici jest*. V &ervenci 1593 se néesky Krumlov obrétil s dopisem vimperky
meéstan Adam Prykhier, ktery si&toval, Zze v roce 1591 zaslal 12 prostic soli, za

kterou mu nebylo dosud je&taplaceno (Stary 2002).

Po z&kazech dopravy bavorské soli(h v druhé polovinl6. stoleti a pak
znovu v dob pokelohorské, doprava soli po vimperské ¢espadala. Nikdy uz
nedosahla byvalého vyznamu (Andreska 1994). Tedygtlivych tvi Zlaté stezky
se Habsburkové potom pokouseli vyu#itiudovani novodobé siléi sit, ale jako
vhodna se ukéazala pouze Vimperskéev, dnes téif totozna s mezinarodni silnici
v Némecku pes hranini prechod (Praxl et al. 2011).

3.2 Redené tzemi

Velké a zachované Useky pistatki Zlaté stezky pojmenovali Kuiba Zavel
(2007) ve své metodice tzv. ,systémy”. Vimperskatiev rozalili cekem na 3
vyznamné Useky: Kubolisky systém mezi ArnoStkou a Kubovou Huti, Zlibsky

systém jihozapadnod Horni Vitavice a Systém na Obecnim vrchu npap@menné

hofe u Strézného.
3.2.1 Systém na Obecnim vrchu

Systém na Obecnim vrchu je gasti posledniho Useku vimpersk&we na
ceském uzemi. Celkévje dlouhy pes ti kilometry a prochazi velic&lenitou
krajinou mezi obci Strazny a stani hranici méeiskou republikou a Spolkovou
republikou Nemecko. Tento Usek byl cely v hranim pasmu a prakticky vice jak
Ctyricet let veéejnosti nepistupny. Diky tomu se zde zachovalo mnoho cennych

pozistatki Zlaté stezky.

Vyzkum ukazal, Zepvodni trasa Zlaté stezkygkraiovala za dnesni osadou
Strazny horské sedlo mezi@ba vrcholky Obecniho vrchu a 8fovala tak pimou
cestou na jih do prostoru dneSniho htaitio pechodu Strazny/Philippsreut
k zemské hranici. Na konci své existence (17. &tk 18. stoleti) potom Zlata
stezka Obecni vrch obchazeldbfizné po trase dnesni zRiznaiené turistické cesty
ze Strazného ke statni hranici. Tato &éwvtrasa je zachycena na niaproku 1736,
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a pivodni starSi trasa je dokumentovana mohutnymigtatky stezky na Obecnim
vrchu (Kuhi, Zawel 2007).

Na Obecnim vrchu se dochovaly rozsahléigtatky Zlaté stezky. Jedna se o

nasledujici Useky pdstatki:

VII 1 - nejrozséhlejSi nesparndochovany poistatek na VI Useku
vimperské ¥tve tvai spol&né s nesporét dochovanymi parstatky VII 2 a VII 3
Systém Obecni vrch. Rozklada se od severniho @iztniho vrchu i@s horské
sedlo mezi jeho almma vrcholy az téwt k jiznimu Upati, kde kafi usek VII 3.
Systém je 800 matrdlouhy, misty aztyrkolejny, a rkteré jeho koleje dosahuji
Gctyhodnych rozréria. Zvlasg impozantni, 55 meirdlouha kolej, ktera na vrcholu
stoupani petina sedlo mezi @ma vrcholy Obecniho vrchu, panesporg k vibec
a az @Bt metii hluboka. Ostatni koleje tohoto Useku js@tBinou jeden aZit metry
Siroké a jeden aZ dva metry hluboké. Z&kladni lioleoto Useku je doprovazena
fadou spojek mezi jednotlivymi kolejemi, zkratek dbotek. Cely Usek je po celé
sveé délce velmi ddk dochovan, prawgodobr také diky skuténosti, Ze tato trasa
byla jiz rekdy v 17. stoleti opu8ha a nahrazena zap&grpoloZenou trasou novou
(Kubt, Zawel 2007).

VIl 2 — pozistatek nowjSi trasy, ktera obchazela zapadni vrchol Obecniho
vrchu. Z&ina v prostoru byvalého signalniho hkariho zatarasu z doby socialismu,
asi 350 meftr zapads od starSi silnice z Vimperku a StrdZzného k statanici, a
sice na migt kde se nogjSi, turisticky znaena cesta zina stéet na jih, a odkud
potom stoupé az na maly vrcholek s byvalou k&pli. Ste tohoto Gseku dosahuje
az étyt mett, a hloubka kolisa mezi jednim aédva metry. Cesty je misty lemovana
nizkymi kamennymi zidkami, afipezitostré lze vidkt i kameny, které mohou
pochazet ze starého dl&hil Na vrcholu stoupani, n&ikovatce turistickych cest je
tento Usek ferusen, brzy vSak pokfaje dale a za stalého klesani seispi Upati
Obecniho vrchu na jih. Potom se pozvoliiengnuje v lesni cestu. Celké\e tento
usek dlouhy asi 400 mét(Kuba, Zawel 2007).

VIl 3 — navazuje na jiznim Upati Obecniho vrchu na 88ek. Jedna se o
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dvé velmi dolire dochované Uvozové cesty, které jsou hlubotizraay do lesniho
terénu mezi malou kamenitotignou zdi na severu a senikem na okraji lesa na jihu.
Ok¢ koleje EZi souldzne a dole u seniku se znovu spojuji. Rovné Useky séitlaji

se zatdkami. Leva kolej je hlubsi, prava SirSi, acatretelre klesaji dol jiznim
smérem. Cely Usek je celkéwdlouhy asi 100 meir Leva kolej je jeden az dva metry
Siroka a doif metifi hlubokd, a prava kolej je jeden &¥ii metry Siroka a do dvou a
pal metru hlubokd. Tento Usek je nejlepSiniikladem Zetelrt dochovaného
pozistatku staré cesty (KibzZawel 2007).

Obr. 3.2 Systém na Obecnim vrchu (Kubavel 2007)
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4 Pouzité geodetické metody

V néasledujicich kapitolach jsou zmiity geodetické metody, které byly

pouzity @i méfeni v terénu.
4.1 Polygonové p#ady

Polygonovy pead je definovan dleCSN 73 0401 jako spojnice vrcliol
prostorové lomenéary. Je zarien pomoci rsrenych délek a vodorovnych dihl
Svec, Hanek (2006ka, Ze polygonovy pad je lomen&éara spojujici dva fické
body. Ve vrcholech lomenétary lezi polygonové body. ifmé spojnice
polygonovych bod jsou polygonové strany. V polygonovych fadech se #fti

délky vSech stran a levostranné vrcholové uhly$ech polygonovych bodech.

Z hlediska délky stran seld polygonové peady s dlouhymi stranami (200
az 1500 m) a na pady s kratkymi stranami (50 az 200 m).

Polygonovymi péady se utuji body PBPP (podrobné body polohového
pole). Zhugovaci body se iftom pripojuji vyhodré na body zakladniho bodového
pole. Ostatni PBPP sdijpojuji na body zakladniho bodového pole, zlow&ci body
a na ostatni body PBPP. Polygonovyigmb musi byt oboustra&npiipojeny a
oboustrana orientovany. Polygonové pady kratSi nez 1,5 km mohou byt
orientované jednostradinpogipacdt i neorientované (vetknuté). Neorientované
porady mohou mit nejvySe 4 strany a dovoluji-li to loksti, alespd na jednom
z vrcholi se zamsii orient&ni Ghel (Ratiborsky 2000). Geometrické parametry a

kriteria presnosti polygonovych padi:

Pripojovaci Mezni délka | Mezni délka 'Meznl’ odchylka v uza¥ru poiadu Urovany bod
body strany [m] poiadu s [m] | Uhlova [mgon] Polohovéa [m]
ZBP, body GPS| 200 - 1500 4500 20(n42) | 0,0018Es)%+0,02 ZhB
ZBP, ZhB 200 - 1500 5000 25(n+?) 0,0025Es)"2+0,04 | Ostatni PBPP
ZBP, ZhB 50 - 400 3000 100(n+%) 0,005Es)?+0,04 Ostatni PBPP
OstBa;,'? 'thoéjy’ 50 - 400 1500 100+ | 0,005Es)%+0,10 | Ostatni PBPP

Tab. 4.1 Pesnost polygonovych fadii (Ratiborsky 2000)
pozn.: n — p&et bodi paradu Wetrg bodi pripojovacich

¥s — sodet délek stran gadu
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Pouzity polygonovy pad:

* Oboustranné pripojeny a oboustranrg orientovany polygonovy pdad
- jsou znamé sdadnice poateiniho i koncového bodu adiené orientace
na obou bodech

Obr. 4.1 Oboustranhpripojeny a orientovany polygonovy aal
(Lacind 2011)

4.2 Tachymetrie

Slovo tachymetrie {@ve tacheometrie) vzniklo slozenim dvéeckych slov
(tacheo — rychlost a metrein —&ht). Cili do ¢estiny FeloZeno rychlorictvi.
Universalnost v nazvu ozégie, Ze jeji vyuziti je mnohostranné. Je nejpoukijé
metodou, protoZzeipjejim pouziti Ize wit nejen nadmiskou vySku podrobného
bodu, ale i jeho polohu (Chamout, Skala 2003). dddgereceno, podrobny bod je
uréen prostorov jedinym zandienim. Tachymetrie je prakticky polarni metoda se
souwasnym uéenim vysky bodu. Nkené prvky jsou: vodorovny sin zenitovy Ghel
a vzdalenost (Hauf 1982). Velméasto se pouzivA nejen pro vyhotoveni
vySkopisného, ale zarofrepolohopisného planu, zejména pro ipby invesitni
vystavby, kdy lze fipustit nizSi pesnost v poloze (Blazek, Siepa 2006).

V sowasné dob se nejastji pouziva k tachymetrii totalni stanice, coz je
v podstat elektronicky teodolit, ktery vzdalenost¢th pomoci elektronického
dalkoméru a uhly jsou od#dtany pomoci elektronického systému na kddovych
kruzich. Velikost Uzemi, které lze z&fih z jednoho stanoviska, je omezeno
dosahem totalni stanice, tvarem terénu, hustotoasponebo zastavby. Tato metoda
secasto pouziva pro da¥eni zakrytychtasti izemi, které nebylo mozné vyhodnotit

nagiklad fotogrammetricky (pod vegetaci).
4.3 Globalni navigaéni druzicovy systém

Globélni navigani druzicovy systém afpgl. Global Navigation Satellite

System — GN$$ souhrnny termin k oztani globalnich druzicovych systém
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Tyto systémy nam umdgji urtit piresnou polohu &as kdekoliv na Zemi i nad
Zemi. Diky své pesnosti a rychlosti #teni se dnes GNSS velrsasto pouziva i

v geodézii. VCR se vyuziva gkolik navigasnich systéra.
* Navstar GPS

Navstar GPSangl. Global Position Systgne vojensky navigai druzicovy
systém provozovany Ministerstvem obrany Spojenytdti samerickych. Vyvoj
probihal od konce 50. let 20. stoleti a navazowalndmaéni navig&ni systém
TRANZIT. V 80. letech bylo rozhodnuto o uvelmi systému pro civilni dely.
Vyznamnym datumem je 2. &na 2000, kdy byl zruSen v§tovy piistup SA angl.
Selective Availability ktery sniZzoval horizontalni i vertikalnitgsnost pro civilni
(neautorizované uzivatele). AvSak Spojené staposechaly pradvo omezit silu nebo
presnost signalu GPS nebo dokonceejrey ristup zamezit Upknag. v doke valky
(Cabelka 2008).

* GLONASS

GLONASS (us. Globalnaja navigacionnaja sputnikovaja émat) je pasivni
dalkomérny druzicovy radiovy navigai systém, ktery je nyni spravovan Ruskymi
vojenskymi kosmickymi silami pro piaby ruské vliddy. GLONASS je obdobou
americké GPS a od roku 1995 je k dispozici i civiiruzivatehm (Rapant 2002b).

« Galileo

Galileo je planovany autonomni evropsky navigadruzicovy systém. Jeho
vystavbu zajiBuje Evropska unie (EU) representovana Evropskouisio(EC) a
Evropskou kosmickou agenturou (ESA). Jelikoz Nav&®S i GLONASS jsou
vojenské navigmi systémy bez zaruky, Ze ve vyjitmgch situacich budou pin
funkéni i pro civilni vyuziti, je systém Galileo navrzgako projekttizeny a
spravovany civilni spravou. Galileo ma poskytovg$si esnost dostupnou vsem
uzivateim a Wwtsi pokryti signalem ({abelka 2008). Prvotni spdai systému je
planovano na rok 2014/2015. PIna dostupnost a tevalbskytovanych sluzeb se
predpoklada v letech 2019/2028 plném zprovoz#éni systému.
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4.3.1 Rychla statickd metoda

Pro zjiStni sodadnic orientaci pomoci GNSS byla pouZita tzv. ,fgch
staticka metoda.” Tato metoda je ekon&j$i variantou statické metodyéieni a
je pravé&podobré nejpouzivansi metodou v geodézii. Doba observace na bodech je
zkracena na 10-30 minut podle typuisgproje, vzdalenosti mezifiimaci a
konfiguraci druzic v okamziku #iieni (Rapant 2002b).

4.3.2CZEPOS

Ceska & permanentnich stanic pro¢owani polohy — CZEPOS umidje
uzivateli zgresréni urkovani polohy i pouZivani GNSS na Gzer@eské republiky.
D¢je se tak pomoci permanentnich stanic, na ktergob kontinuéld provadna
meieni signal naviga&nich systém GNSS. Namena a odvozena data (korekce)
jsou distribuovana uZzivaiah. Sowdasre sit’ zprostedkovava sluzby pro ¥esréni

polohy ugené aparaturou uzivatele (Vilimkova 2006).

CZEPOS obsahuje 28 permanentnich stanic rogn@nrozmistnych ve
vzdalenostech cca 60 km. Celkovy¢pbzahrnuje 28 stanic umiafch na izem{’R
a 27 gihrangnich stanic statnich siti GNSS sousednichistdtn GzemiCeské
republiky je 23 stanic CZEPOS, které jsou ve sprdememerického Gadu a jsou
umisgéné na budovach katastralnickadi resp. pracoviSa dale 5 externich stanic

spravovanych &deckymi a akademickymi pracovis€\ZK 2013).
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Obr. 4.2 Mapa referemich stanic CZEPOS(UZK 2013)
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Refererni stanice ve spré&wZememéiického Gadu, jsou vybavenyipimaci
Leica GRX 1200+ GNSS, které ummnii prijem signah druzicovych systéinGPS
NAVSTAR i GLONASS a jsou fipraveny na fijem signah z druzic GALILEO.
Prijimace zajifuji permanentni s dat 24 hodin derins intervalem zaznamu 1
vtefina, zalohovani dat na compactflash kadtjirpace a distribuci dat na centralni
servery CZEPOS prastdnictvim zabudovaného ethernet poRtijimace zaji§ujici
data pro postprocessing jsou na servéen@Sena v pravidelnych hodinovych
intervalech formou hodinovych souliprdata pro sluzby v realnérsase jsou

pienddena bezprdstirt po pdizeni formou datovych paketCUZK 2013).
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5 Geografické informaéni systémy

Pro GIS éangl. Geographical Inforamtion Syst¢ neexistuje jednotna
definice. Velice ¢asto se pouzivaji definice (Burrough 1986; Vozdnil998).
Brehovsky, Jedika (2006) definuji GIS jako inforndai systém, ktery pracuje
s prostorovymi daty. Naproti tomu Rapant (2002&pehGIS verech Urovnich: GIS
jako software; GIS jako konkrétni aplikaci; GIS gaknformani technologii. Asi
nejpresrejSi definici a zarove nejlépe pochopitelnou najdeme na oficialnich
strankach spotmosti ArcData Praha (2013), ktera zni: ,Geograficghformasni
systém je organizovany souhrn ¢fiacové techniky, programového vybaveni,
geografickych dat a zatstnan@ navrzeny tak, aby mohl efekti#rziskavat, ukladat,
aktualizovat, analyzovat, ignaSet a zobrazovat vSechny druhy geograficky
vztazenych informaci“. Jina, velniasto pouzivana definice je od spwlesti ESRI
(Enviromental Systems Research Instjty2013): ,GIS je organizovany soubor
pocitatového hardwaru, softwaru a geografickych uddd@paplrené baze dat)
navrzeny na efektivni ziskavani, ukladani, upramgvaobhospodavani,
analyzovani a zobrazovani vSech forem geografickpébrmaci.“ Pro upesréni
muzeme uvést definici obrac&nco neni GIS? Neni to pibacovy systém na
vytvareni map, &oliv mapy vytv&et mize, nebé GIS je hlave analyticky nastroj.
A GIS také neni CAD (oliv pavodni mySlenka z CADu vzesla). CAZ¢mputer
Aide Drawning/Desighje wtSinou pouZzivan pro vyt¥ani novych objekt, kdezto
GIS slouzi k analyze a modelovani existujicihétavwetre historie (Behovsky,
Jedlitka 2006).

5.1 Representace dat v GIS

V zasad existuji dva zakladni figoby representace udaj GIS, vychazejici

z protikladnych moZznosti modelovani prostoru:

a) explicitni (rastrova) representace, oamaana i jako mozaikova (tessétd),

kterd vychézi z modelovani pomoci poli — absolatmitodelovani prostoru

b) implicitni (vektorova) representace, ktera vychénbjektového — relativniho
modelovani prostoru (Tek 1998).
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5.1.1Rastrova representace

Zakladnim stavebnim prvkem je u rastrové struktawy buika (cell, pixe).
Buriky jsou organizovany do tzv. mozaiky. Jednotlivénkyu obsahuji hodnoty
(valueg zastupujici zkoumanou lokalitu i{@ovsky, Jedika 2006). Mozaikovy
model mizeme z prostorového hlediska vbldefinovat jako prostora@vna sebe
navazujici mnozinu dvoj- nebo trojrogmych elemerit rizného tvaru a velikosti,
které kompleta vypliuji zkoumanou plochu (Tek 1998). Rastrovou representaci

muzeme rozdlit na:

» pravidelné rastry — @i kterych je tvar poli fesré definovany a vzdy stejny
(¢tverec, obdélnik, Sestiuhelnik, trojuhelnik). Tyastry se daledi na:
a) rastry se stejnou rozliSovaci UrovApole stejn velka,
b) rastry s nestejnou rozliSovaci urovni nebo hierégkbu strukturou— velikost

poli se definovanym Zigobem nini.

* nepravidelné rastry — pxi kterych se vytvéeji pole fizného tvaru i velikosti
(Worboys 1995 in Teek 1998).

NejpouzivasijSi rastrovou representaci je pravidelitéercova niiizka, a to

piedevsim zeit praktickych divodi:

* je kompatibilni se strukturami datovych strukturuptvanych ve vypgetni

technice (matice),

* je kompatibilni gadou hardwarovych Faeni pro zdznam a vystup dat

(skenery, tiskarny, plotry),
* je kompatibilni s kartézskymi stadnicovymi systémy (VoZenilek 1998).

Kazda pravidelnd mozaika seibe ¢lit na podrobgjSi rastrové uspgadani,
tzv. vnaenych bugk. AvSak pouzectvercova buika si rekurzivnim &enim
zachovava tvar i orientaci. Trojuhelnikové nky délenim Zistavaji stéle
trojuhelnikové, ale orientace jiz neni u vdech mbvipurek stejnd. Sestithelnikové
buiky nelze dlenim zmensSit tak, aby si ponechaly stejny tvarléK@003). Oproti
tomu hlavni vyhodou pravidelné hexagonalrtizky je, Ze stedy vSech sousednich

od stedu dané hitky jsou steji vzdalené. Tato symetriéni tento model vyhodnym
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pro rekteré analytické funkce. Toto je nemoznéchaercové niiizce, kde diagonalni
sousedé nejsou ve stejné vzdalenosti jako sousettgiech zakladnich sénech od
centralni biiky (Tu¢ek 1998).

Pro popis Bkterych prvki a jeva se s vyhodou pouzivd mozaiky, teaé
buinkami nejen #izné velikosti, ale iizného tvaru. Pro geografické aplikace se
obvykle pouzivaji mozaiky slozené z trojuhelhik nebo nepravidelnych
mnohouhelnil. Nepravidelné rastrové modely jsou vSak sf&itna tvorbu i praci
nez pravidelné rastry. Jsou sestaveny vzdy jenuyxtity druh dat a analytické
zpracovani (Kol&2003). Nepravidelné rastry jsou vhodné pro reprtese terénu a
povrchu. Nejastji vyuzivaji trojuhelniky s promnlivou velikosti a tvarem, tzv.
nepravidelni trojuhelnikové si{angl Triangulated Irregular NetworRsTIN. TIN
representuje povrch jako soubor trojuhelnilkteré jsou definovanyrémi body
umisenymi kdekoliv v prostoru a pro tyto trojuhelnikyhavava topologické vztahy
(Biehovsky, Jedtka 2006).

5.1.2Vektorova representace

Pro vektorova data je charakteristicky zpfedkovany vztah meazi
prostorovou a inform#@i sloZkou datového modelu. Prostorova i tematicka
informace je vazéna k identifikatoru objektu, ktggywakladnim prvkem vektorovych
dat (Vozenilek 1998). Ve vektorovém datovém mod&ipro popis geometrickych
vlastnosti geoprvk pouZzivaji linearni geometrické prvky, tzv. vektoryyto

vlastnosti jsou znazoény pomoci ti zakladnich geometrickych prirk

* bod - jako vektor nulove&ary (vektor, u ghoz splyne p&ateeni a koncovy
bod).

* linie — jako otewena posloupnost vekiir U linie rozliSujeme pé&ateni a
koncovy bod, které se ozhgi terminem uzel fod a mezilehlé body,

vrcholy (vertey.

» plocha — representovana svoji hrani linii, kter4 je uzakena, popsana

uzawenou posloupnosti vekigrresp. linii (Rapant 2002a).

Stejre jako u rastru, tak i u vektoru mameékolik moznosti representace dat.
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Spagetovy model

Nejjednodussi vektorovy model pro geografické édaprincip vychazi
z digitalizace map, kde se kazdy objekt na &nagpresentuje jednim logickym
zdznamem v souboru a je definovany jalettzec X, Y sowadnic (Behovsky,
Jedltka 2006). Pouziti Spagetového modelu je omezenmégeednoduché Ukoly
poitatové kartografické produkce. Spagetovy model nefidee vhodny pro
prostorové analyzy, protoZze jakakoliv informace ziazich mezi objekty, jez je
ziejma i pohledu na fivodni analogovy dokument, se musi odvozovat vigr
(Kolat 2003).

Topologicky model

NejpopularijSi metodou jak zachovat vztahy mezi entitami, x@lieitn¢
zaznamenat, zapsat ,souvislostni* informaci do watbh soubol. Zakladnim
logickym prvkem, entitou linie, v topologickém srhyge hrana. Hrana Zama a
kor¢i v priseticich s jinou hranou, v uzlovém bodKazda individualni hrana ma
zaznamenané ozéeni a sotmdnice svych dvou uzlovych bibd Déle je
zaznamenany identifikator nebo jméno kazdého zguwoly napravo a nalevo od
hrany (Twek 1998), coz velice usnaaje kontrolu konzistence a detekci chyb a
usnaduje také provathi nekterych analyz, jako na@panalyzy siti (Rapant 2002a).

Hierarchicky model

Tento model odstimje neefektivnost i vyhledavani v jednodussSim
topologickém modelu pomoci ukladani v logicky hiehacké podob. Nagiklad i
vyhledavani sousednich polydorse pouZiji jenom data pro polygony a linie
(Bfehovsky, Jedtka 2006).

5.1.3 Porovnani rastrové a vektorove representace

Obecrt Ize tici, Ze vektorova representace se vice hodi praimektaci
objektl a presentagiar. Kdezto rastrova je vho#8i pro prostorovou proémnost a
presentaci ploch.
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Rastrova representace

Vyhody Nevyhody

jednoducha datova struktura nsédompaktni datova struktura

jednoducha kombinace s jinymi rastrovymi Udapro transformace jédba specialnich algoritim
(DPZ, fotogrammetrie)

jednoduché vykonavani analytickych operaci | fespost zavisla na velikosti ky

vhodnost pro modelovani a simulace nevhodnost patyay siti

jednoducha tvorba uzivatelskych nadstaveb velkgmhbjlozenych Ud4j

Vektorova representace

Vyhody Nevyhody
vysokda polohovaiesnost objekt komplikovanost struktury
kompaktnost struktury nevhodnost pro souvislé payrc
graficky vystup je blizky klasickym mapam slozZitegpactt pii analytickych operaci

vhodnost pro modelovani individualnich objeki vypotetni nargnost, pateba specializovaného
softwaru, kvalitniho hardwaru

maly objem uloZenych Gdaj ¢asow nara@né vytvdeni topologie
presné transformovani siadnicovych systéin | nevhodnost pro prostorové modelovani
a simulace

Tab. 5.1 Porovnani rastrové a vektorové representac
(Kolar 2003, Tuek 1998, Vozenilek 1998)

5.2 Digitalni model terénu

Digitalnim modelem terénu (DMT) se ¢étginou rozumi prostorovy

geometricky popis reliéfu terénu. Na tomto reliéfa dale modelovat a popisovat

viv s

piirodnich i unglych objekfi, hranice spravnich cealk hranice povodi, apod.
(Sindel& 1999). Prostorové modelyibeme rozdlit:

» digitalni model reliéfu (angl. Digital Terrain Model)

 digitalni model povrchu (angl. Digital Surface Model)

+ digitalni vySkovy model(angl. Digital Elevation Model)
Digitalni model reliéfu

Digitalnim modelem reliéfu se rozumi zemsky pbvbez vegetace a staveb.
Definice DMR v terminologickém slovnikiCeského tadu zemiméiického a
katastralniho (2013) zni: ,Digitalni model terémliéfu je digitélni reprezentace
reliefu zemského povrchu v péth potitace, slozena z dat a interpdhdho
algoritmu, ktery umoiuje mj. odvozovat vysky mezilehlych binti Podle Krchy
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(1979 in Twek 1998) jde o: ,reprezentativni soubor baeliéfu terénu vybranych
podle utitych pravidel, poloho¥ lokalizovanych a fitazenym vektorem (sloupcem
hodnot) parameir reliéfu terénu. Jde tedy o body, informace o néclpravidla

pouzivani &chto informaci.”
Digitalni model povrchu

Digitalnim modelem povrchu je prakticky digitaimiodel reliéfu rozgeny o
piirodni i antropogenni pokryv. Digitalni model pdwc byva vysledkem
automatizovanych metod vyhodnocovani vySek fotognatrie. Pouziva se
v pripadc modelovani krajiny, modelovani &st, @i vizualizacich, analyzach
viditelnosti apod. (slovnik VUGT 2013).

Digitalni vySkovy model
Digitalni vySkovy model je model reliéfu pracujigthradré s nadmeskymi

vySkami bod (slovnik VUGT 2013). Velmiasto je chapéan jako rasttt\ercova

sit) s pravidelnou hustotou bdd
5.2.1Zdroje dat

Data pro terénni model ttheme ziskat ¢kolika zpisoby: pozemnim
métenim, dalkovym pizkumem nebo digitalizaci jiz stavajicich dat (asgji
vektorizaci vyskopisu). P volbé vhodné metody je nutné zohledniizna kritéria

nag. velikost Uzemi, poZzadovanéegnostgasova a finatni nar@&nost.

V pozemnim mdfeni se nejastji pouzivaji d¥¢ metody. Prvni z nich je
tachymetrie (kap. 4.2). Tento i{gob nejpesrEji zachycuje pitbéh terénu.
Nevyhodou jecasova narénost ngreni. PouzivA se pro mensi Uzemi, kde je
pozadavek vysokeéipsnosti a kvality jako na@ppro gesny model terénu velkého
metitka, technicka dila nebo pro projek (ely. Druhd metoda je vyuziti GNSS.
Vyhodou této metody je rychlost ¢ nepotebuje pomocnika) a i@snost.
Nevyhodou jsou vysoké naklady narfzeni gfijimace a omezené podminkyeheni
nag. v lese, nebdprijem signalu GNSS vyzadujgst nezakrytého obzoriéireni
podrobnych bodl pro tvorbu modelu terénu pomoci GPS/GNS&eme metodou
diferertni GPS éngl. Differential GPS — DGPHShebo metodou RTKahgl. Real
Time Kinematics Metoda diferetni GPS funguje na principu oprawtani
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v terénu. DGPS obsahujet’ dtanic, které prova§l méieni 24 hodin denna jsou
znamy jeji sotadnice. Referami stanice spiitd korekce a ty jsou odeslany GPS
piijimag¢i v terénu. S referernich stanic \CR se nazyva CZEPOS. Metoda RTK je
podobna DGPS, ale klade vysSSi naroky na technickéaweni, neb® mezi
referenim a pohyblivym fijimacem musi byt vybudovan staly komunika kanal
(Rapant 2002b)

Déalkovy pfizkum zastupuji fotogrammetrické metody, radarovinani a
laserové skenovani. Fotogrammetrie je powd piesnd, levna a rychla metoda. Pro
tvorbu DMT se nejastji vyuzZiva letecké stereofotogrammetrie. Ke zpraooysou
zapotebi vzdy dva snimky, které byly ipeny kazdy jiného mista, ale zobrazuji
stejné uzemi s titym preryvem. Nasledné zpracovani sninychazi z praktického
vyuZziti stereoskopického viemu, ktery umaje lidskému zraku prostorové vnimani
okolni reality (Janec, Fb2004). Druhou metodou dalkovéhaipkum je radarové
snimani. Radarové systémy mohou k¥oabrazovych dat poskytovat navic dalSi
specifické informace. i#® radarovém snimani iie byt pouZito radarové
interferometrie (INSAR) nebo altimetrie. Interfereimi je ziskano radarové echo
stejného mista Ziznych poloh. Zrozdil fazi radarovych signél se ziska
interferogram a relativni vySkové rozdily jednofith prvki se pevedou na
nadmdské vysky. Na podkladinterferometrického &teni byl zpracovan projekt
SRTM f(@angl. Shuttle Radar Topography Missipfenz poskytl digitalni vyskovy
model celého zemského povrchu ifegmosti do 16 m (Li, Zhu, Gold 2000).
Radarova altimetrie vyuzZiva zaznamenani radaroeéha jaka:asovy interval mezi
vyslanim a pijetim signalu a jako signal modifikovany povrché¢ilimanek 2006).

Jelikoz se mikrovinné %éni Sti konstantni rychlosti, fize se sp&itat vzdalenost a

spole&né s dalSimi parametryippaite na absolutni vySku. Laserové skenovani
LIDAR (ang. Light Detection and Ranginge pouziva od 70. let minulého stoleti,
ale dnes se stava stale progreg&inmetodou pro mapovani. Zakladnim principem
je dalkongrné nereni pomoci laserového svazku pajfirskiicemz je nutné znat

piesnou polohu skeneru a &mvysilani paprsku. Laserovy paprsek se postupn

odrazi od jednotlivych vrstev objékha zemském povrchu. Diky tomu |ze hawi
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mapovani lesnich pordstziskat jak odraz od svrchnfésti koruny, tak od
jednotlivych pater a samigm¢ od samotného zemského povrchu.

Poslednim zfisobem, jak ziskat vySkopisna data pro vigvid modelu terénu
je digitalizace analogickych map. Je dog®no zvektorizovat nejen vrstevnice, ale i
tzv. povinné hrany, jako jsou hrany a paty svattrZze, libetnice, udolnice, okraje
silnic atd. Digitalizaci je mozné prov&dmanualg, s tiznym stupsm automatizace
nebo plk automaticky. Je to relatignevna metoda, avSak nedosahuje tak vysoké

piesnosti.
5.2.2 Datova representace modadl

Tucek (1998) rozduje digitalni modely terénu podle typu ploch, zerigch
jsou tvaeny:

» rastrové modely— vyuZivaji @¢leni plochy na pravidelné, st&jmelké plosky

» polyedrické modely — vyuZivaji @leni plochy na nepravideln&arg velké
plosky, obvykle trojuhelnikového tvaru, na &ith plochach se pouziva

linearni interpolace

» platové modely — vyuZivaji @leni plochy na nepravidelnéjar¢ velké
plosky, obvykle trojuhelnikového tvaru, na &ith plochach se pouziva

nelinearni interpolace, zohkagie se pitbéh plochy na sousednich platech.
Rastrové modely terénu

Jak nazev napovida, model je dan mnozinou elemeabaploSek nad prvky
pravidelného rastru. Vypovidajici schopnost modde zavisi na jeho rozliSovaci
arovni, na kolik jsou jednotlivé prvky rastriimknuty ke skuteénému reliéfu terénu
(Sindel& 1999). Kazda bitka nese hodnotu nadisié vysky vztaZenou keistiu
burky (grid) nebo k uzlu izky (lattice) vytvdené buikami (Vozenilek 2001)Maji
vSechny vyhody rastrovych datovych representady tevliast jednoduchost a
lehkou pochopitelnost struktury. St&jmak jednoduchost postiippii nasledném
zpracovani pro vypity odvozenych paramétra pro poateby zobrazeni (Taek
1998). Rastrovy digitalni model terénu je vhodng prodelovani relativhplochého
reliéfu bez nahlych vyskovych zm (Rapant 2006).
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Nepravidelné trojuhelnikové &it

Nepravidelnd trojuhelnikovatsTIN (angl. Triangular Irregular Network je
topologicka struktura reprezentujici reliéf teréfRapant 2006). TIN vyuziva
rozckleni terénni plochy na dil plochy, nejastji trojuhelnikového tvaru. Vlastni
proces vytveéeni si€¢ se nazyva triangulace i{@&ovsky, Jedtika 2006), ta je dena
negasgji Delaunayho podminkou tj. viigk kruhu opsaného libovolnému
z trojuhelniki sit neobsahuje Zzadny dalSi bod ésia velikost vSech uhl
v trojuhelniku je maximalni (Klimanek 2006). Vyhadt&chto modei v porovnani
s rastrovymi modely je zmenSeny objem uloZenychjiida moznost odvodit,
vypaocitat hodnotu vysky terénu (hodnota funkce Z) ptmvolny bod zkoumané
plochy. Jsou tedyipsrEjSi a vhodgjsi pro praci s liniovymi objekty. Nevyhodou je
naopak slozitost struktury a postupu jejiho vznilstejreé tak odvozeni jakékoliv

informace je mimtadre vypacetns naraéné (Twek 1998).
5.2.3 Digitalni modely terénu vCeské republice

V Ceské republice existujeskolik digitalni modeh terénu. Na vytvéeni a

spra¥ téchto moded se podili:
« statni sektorCesky tad zerdmeticky a katastralni

» vojensky sektor: Vojensky geograficky a hydrometémgicky UGad

v DobruSce
» soukromy sektor: n&pArcData Praha, Geodis Brno
Nize jsou popsany pouze modely, které byly pouzityplomové praci.
« ZABAGED®

Zakladni baze geografickych dageské republiky — ZABAGED® je digitalni
geograficky model GzemiR na Grovni podrobnosti Zakladni mapR 1:10 000
(ZM 10). Polohopis tvii v sowtasné dob 123 typi geografickych sidel, komunikaci,
vodstva apod. VySkopis t¥io3 typy objeki vrstevnic se zakladnim intervalem 5, 2,
nebo 1 m v zavislosti na charakteru terénu. ZABAGEDvySkopis — 3D vrstevnice
je doplren vybranymi dalSimi vySkopisnymi prvky, které bylyyhodnoceny
stereofotogrammetrickou metodoti ppresiovani vrstevnicového vyskopisu.
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VySkopisnouc¢ast ZABAGED® dale dopluje odvozeny digitalni model terénu v
podok¥ pravidelné miZe (10x10 m) trojrozirné vedenych (3D) bad Vydejni
jednotkou je mapovy list ZM 10 (18 Kinve forméatu *DGN7, *DXF nebo *SHP pro
polohopis, a *TXT nebo *SHP pro vySkopis 3D Iiod Podporovanymi
soudadnicovymi systémy jsou S-JTSK / Krovak EN, WGSa8A/GS 84 / UTM zone
33N (CUZK 2013).

* DMR 4G

Digitalni model reliéfuCeské republiky 4. generace — DMR 4@&dgstavuje
zobrazeni firozeného nebo lidskowinnosti upraveného zemského povrchu v
digitalnim tvaru v pravidelné siti (5x5 m) hiod sodadnicich X, Y, H, kde H je
vySka v referetnim systému Balt po vyrovnani (Bpv) s Uplnotedhi chybou vysky
0,3 m v odkrytém terénu a 1 m v zal&sém terénu. Vydejni jednotkou je mapovy
list SM 5 (5 knf) ve formatu *TXT, v sotadnicovém systému S-JTSK / Krovak EN.
Tvorba tohoto modelu byla zahajena na pasmietBt roce 2009. V saiasnosti je
vytvoien DMR 4G z pasma ,Btd“ a ,Zapad®, tj. 67,9 % UzendIR, tj. 53 529 k.
Predpokladané pokryti celého GzefR je v roce 2013(UZK 2013).
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6 Pouzity software

6.1 Leica Geo Office

Leica Geo Office (LGO)je vysoce automatizovany set progianktery
zpracovava vsechny typy GPS, TPS a nivmleh dat péizené vSemi zjsoby
meéfeni. Systém umaitije importovat RTK rdfeni a kombinovat je s daty pro
nasledné zpracovani (post-processing). Vysledky acgwani ndfeni jsou

zviditelnény v systému WGS84 i v lokalnich systémech defingeh uzivatelem a

mohou byt exportovany do syst@ntlS a CAD. LGOobsahuje velké mnozstvi
podpirnych program, funkci a knihoven péebnych pro produktivni praci s
technologii Leica Systému 1200. Jsou to seznamyi kdditribudi, kartograficka
zobrazeni, nastroje pro generaci elipgaedmodel geoidi, ukladani dat na &eni
dat ze senzdr UZivatelé mohou také tyvib viastni vstupni a vystupni forméty
(GEFOS 2013).

6.2 GROMA

Program GROMA je wen ke geodetickym vygtim. Lze v @m feSit
vSechny zékladni geodetické ulohy. Navic obsategegduchou grafiku a moznost
digitalizace rastrovych dat. &f%eni lze gimo importovat z formdt vSech Bznych
zdznamnill. Po oteveni jsou vSechny naffené hodnoty zobrazeny v datovém
okr¢, z rthoz Ize mySi fetahovat do vypsetnich dialogovych oken. Program
obsahuje nap tyto ulohy: polarni metoda, ortogonalni metodalne stanovisko
(protinani zpt), protinani ze sw#mi, protinani z délek, polygonové faaly (i
s vySkopisnym vypétem), transformace stadnic atd. B vSech vypétech vznikaji
automaticky textové protokoly o vypin. Pro vypdty je mozné sestavit libovolny
pocet sad toleranci, jejichzigkraieni program automaticky testuje, a ipad
potreby zobrazi varovné hlaSeni. Program GROMA uing kompletni zpracovani
zapisniku. Navic lze #teni opravit o vliv refrakce a z#ikeni, o vliv indexové
chyby, a lze davkay spaitat prevySeni zenitovych Ghl Dale umo#uje piimou
komunikaci se systémem MicroStation a PowerDratftligitalizaci naskenované
mapy ve forméatu *BMP (GROMA 2013).
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6.3 MicroStation

MicroStation je zaklademieSeni spoknosti Bentley pro architekturu,
stavebni inZzenyrstvi, dopravu, zpracovatelskynpysl, vyrobni z#&zeni, statni
spravu a samospravu a inZzenyrské a telekomamilag. Uzivatefim umo#iuje
MicroStation vytvéet 3D modely objekit a budov. Tyto modely a jejich jednotlivé
casti jsou elektronickou simulaci realnych objekt obsahuji vSechny informace

0 jejich parametrech.

Zakladni ,slovnik“, se kterym MicroStation pracujge definovan jeho
vlastnim formatem znamym jako *DGN. Tento formabimeahuje Zadna omezeni
piesnosti, pétu vrstewci velikosti vykresu nebo bwk.  MicroStation V8 ovSem
neni pevl spojen s formatem *DGN, ale dokaze dtewa ulozit i soubory jinych
formati. Jednou z vyhod technologie uwnMicroStationu V8, kterd pro podporu
riznych formah vyuziva princip slovnik, je moznost imo pracovat s *DWG
vykresy vytvdené programem AutoCAD. Diky této schopnosti je M&tation V8
jedinym dostupnym nastrojem, ktery dokaze pracevattma nejpopulargsSimi
CAD formaty. *DWG data zpracovava MicroStation V& stejné udrovni jako
samotny AutoCAD, a to detré grafickych elemerit hladin, pohled a rozvrZeni.
Samotny MicroStation V8 fize interpretovat &Si rozsah informaci, nez jaké jsou
obsazeny v*DWG a*DGN souborech, takZze oba formdyhou byt B praci
formou referetnich vykres libovolné kombinovany. V prosgedi, kde se pouziva
AutoCAD i MicroStation, vyuzivd MicroStation V8 tzwvDWG pracovni rezim,
ve kterém jsou funkce MicroStationu vyuzivany taky byla zachovana maximalni
kompatibilita s *DWG forméatem (Sima 2008).

6.4 ArcGIS

Systém ArcGIS firmy ESRI twdfada Skalovatelnych produkurcenych pro
kompletni nasazeni GIS na jakékoli Urovni. &mii ArcGIS jsou desktopove,
serverové i vyvojiské produkty, nechybi anieSeni pro mobilni Z&eni a

specializované nadstavby (ArcData 2013). ArcGIStifndrovre:

 ArcView — umo#uje prohlizet, organizovat a dokumentovat data.Je

nejzakladgjSim a nejjednodussim modulem ArcGIS.
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» ArcEditor — méa vSechny funkce jako ArcView a navic nastimje editaci

shapefiti a geodatabazi.

* Arcinfo — je nejvysSi verzi GIS software od firmy ESRI.s@buje vSechny
funkce vySe zmigtnych komponent a obsahufadu dalSich pokkidlych
nastrofi pro praci s geodety (Pixova 2007, ESRI 2013).

Do kategorie ArcGIS for Desktop spadaji produktyc@IS for Desktop
Basic, ArcGIS for Desktop Standard, ArcGIS for Diegk Advanced a voln
dostupny prohlize publikovanych map ArcReader. Kazdy ézhto produki
poskytuje fiznou Urové funkcionality, podle pdeby uzivatele (ArcData 2013).
ArcGIS for Desktop obsahujadu vzajemé propojenych aplikaci:

» ArcCatalog — organizuje a uspadava data pouzivana v GIS. Tuto aplikaci Ize
prirovnat nap. k programu Rizkumnik nebo Total Commander, které se
pouZzivaji pro Bzné nakladani se soubory vggaci. Umoziuje nahledy dchto

dat fred jejich otevenim.

« ArcMap - pouzivd se kprohlizeni a editaci geografickgtdt. Umo#uje
vytvareni profesionalni map, giafprojekti a zprav. H vytvareni map se fize
prace ulozit jako mapovy dokument, soubor s konoaviviXD.

* ArcToolbox — je aplikaci umakujici vykonavat GIS analyzy na pokitejSi
arovni. Jednéd se o soubor nésirgro vytv&eni, propojovani, exportovani a

importovani datiznych format (Pixova 2007).
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7 Metodika

7.1 Zaméreni v terénu

Pred vlastnim rdenim bylo nutné provést rekognoskaci terénu. Jeliko
veSkeré nsieni se milo provadt v lesnim porostu, bylo zagebi rozvrhnout si
dolie mefickou st a vytyit v terénu body, které &y poslouzit jako orientace.
Praw vhodnému umighi bodi (orientaci) bylo nezbytnéémovat velkou pozornost

z davodu jejich zamreni pomoci GNSS.
a) Tachymetrie

Pouzité mérické pomicky:
» totalni stanice Topcon GTS 105-N
* stativ
e 2 odrazné hranoly s vytiami
o 2 stojanky

s metr

Tachymetrické réreni bylo provedeno z pomocnych lauérické sit, které
byly v terénu doasré stabilizovany gevenym kolikem. Na kazdém stanovisku byla
provedena centrace, horizontce amma vyska stroje. Stry a délky orientaci byly
meieny v 1. i 2. poloze dalekohledu, podrobné bodgz{st a okolni terén) byly
meieny pouze v 1. poloze. Jelikoz stezka ma tvarreteédho koryta — lichaiznika,
byla zangiena jak jeji horni, tak i spodni hrana.

Topcon GTS 105-N (&. 6H1200)

Technické parametry
e piesnost uhil: 57" (1,5 mgon)
* rozsah kompenzace: 7
* presnost mfeni vzdalenosti: £ 2 mm + 2ppm
» délkové ngieni: 900 m (minihranol), az 4000 m (9 hranol
» dalekohled: z&tSeni 30x, min. zaosivaci vzdalenost 1,3 m

e oboustranny LCD displej

Totalni stanice Topcon GTS 105-N ma rozsahlou gaaz na 24 000 #sitenych
bodi ve 30 zakazkach. M4 velké mnoZstvi aplikiah program a je vysoce odolny
proti negiznivym podminkam protdi.
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b) Zan¥reni orientaci pomoci GNSS
PouZzité mérické pomiacky:
* Leica GPS 1200

* vytycka + ostatni fisluSenstvi

M¢éteni bylo provedeno rychlou statickou metodou (kaf.1). Toto nireni
je velice ¢asto pouzivané v geodézii pro svou rychlost, rfieth@ba observace na
bodk je ponern¢ kratka. Kazdy bod orientace byl z&mn dvakrat. Doba mezi

prvnim a druhym rirenim byla delSi nez jedna hodina.
Leica GPS 1200 (&. SMV 09608671)

Technické parametry:
o trifrekvereni anténa: ATX 1230 GNSS
* prijem: 120 kand
» frekvence: L1/L2/L5 GPS; L1/L2 GLONASS; E1/E5a/EAR/BOC Galileo
» piesnost RTK — staticka (podle 1ISO17123-8):
5 mm + 0,5 ppm (horizontajy 10 mm + 0,5 ppm (vertikad
* Dbluetooth port
» software: RX 1250Xc Windows CE kontroler
 MCF 256 panitova karta Compact Flash 256 MB

Leica GPS 1200 umanje mefeni prakticky vSemi zsoby: statickou metodou,
rychlou statickou metodou, metodou ,stop and gafiekatickou metodou, RTK —
Real Time Kinematics nebo diferari GPS (DGPS). Dédle ma velké mnoZstvi

aplikaci: n&feni bod, vytycovani, transformace stadnice a;.
7.2 Zpracovani vysledki
Vypaiet orientaci

Orientace byly spoitany v programu Leica Geo Office (LGO) za pomoci

Ing. Vlasaka.

V programu LGO byl vytvien novy projekt, do kterého byla nahrana
nantiena data ze systému Leica GPS 1200. \Ygpsouadnic bod zmerenych
pomoci GNSS ma dva kroky — vyfmi vektofi a transformace séadnic do

lokalniho sytému.
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a) vypocet vektori

Jedna se o vyget presného relativniho vztahu mezi refeheinstanici a
rovery. Pokud v terénu neni k dispozici spojeréfereréni stanici, je nutné stdhnout
data z referetni stanice a provést vypet vektoni v programu LGO. Dale je p@ba
nastavit parametry vygtu: vySkovad maskdminimalni Ghlovd vyska druzic nad
horizontem), parametry drah druzic (vysilané; pesné), GNSS typ (GPS;
GLONASS),aktivni satelityfrekvencesj.

b) transformace souadnic do lokalniho systému

Pro transformace v LGO je zapelti dvou projekt: Projekt A obsahujici
vstupni WGS84-ETRS89 siadnice a projekt B obsahujici vstupni isalnice S-
JTSK identickych boil Poté nasleduje vypet transforméniho klice podle pedem
vybrané transformace. V tomtoftipact byla vybrana tzv. Klasicka 3D*
transformace, kdy sdéadnice z obou projektjsou nejdive pomoci zobrazovacich
rovnic grepaiteny na geocentrické kartézské iminice. Na Urovni geocentrickych
kartézskych saadnic probihd vypget 3D Helmertovy transformace, jejimz
vysledkem je 7 prvik 3 posuny, 3 rotace adiitkovy faktor. Tato transformace
vyhovuje pro vSechnyifpady, kdy u identickych bdédzname polohu i vySku v
rovnocenné fesnosti (Leica Geo Office 2007).

Vypa’et polygonového gadu a podrobnych bad

K t¢émto vypatam byl pouzit geodeticky program GROMA v. 8.0. Nepr
byl vytvoren novy soubor sd@adnic: Seznam soadnic, do kterého byly uloZzeny
sodadnice bod — orientaci vyp&ené v programu Leica Geo Office. Poté byl
zaloZen novy seznamdiieni: Seznam éFeni — polarni dataDo toho seznamu byly
naimportovany nagfené hodnoty z totalni stanice Topcon GTS-105 KedP
vypoctem oboustrarth piipojeného a orientovaného polygonovéhaoigoll, bylo
zapotebi spaitat paateni bod — 5001 a koncovy bod — 5032 polygonového
poradu. K tomu ndm poslouzila funke®Iné stanoviskgyrotokol o vypétu volného
stanoviska. Poté jiz bylo mozné gfiat polygonovy ptad funkci —Polygonovy
porad davkou Tento pdad byl spéitan poloho¥ i vySkow, protokol o vypdtu.
Nasledoval vypeet sodtadnic podrobnych bdd— Polarni metoda davkouWProtokol
0 vypaitu polarni metody davkou.
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Zpracovani v programu MicroStation V8

Nejprve byl vytvden novy vykreszlata stezka.dgme formatuseed3d.dgn
ktery zarduje 3D zobrazeni bdida pracuje s nadniskou vySkou (satadnice Z). Do
programu MicroStation byly naimportovany vSechny dyo wetrg¢ bodi
polygonového piadu a jeho orientaci a to diky propojeni progranROMA a
MicroStation. K tomuto propojeni poslouzitikaz mdll load groma Nasled# byly
tyto body spojeny tak, aby odpovidaly skimesti — profilu Zlaté stezky. Tento
mezikrok, import bod a jejich nasledné spojeni v programu MicroStatgmukazal
jako vhodny zpsob ziskani nadniské vySky jak bodl tak i samotnych linii.
Nadmdska vyska se totiz automatickyiimdi jako feti souadnice Z k sotadnicim

X a'Y vyjadujici polohu. Této vlastnosti bude dale vyuzitoragramu ArcGIS.
7.3 Zpracovani v ArcGIS

V programu ArcGIS byl zaloZzen novy pracovni dokamé&lata_stezka.mxd
(File > Save) V tomto dokumentu byl nastaven $adnicovy systém pr&eskou
republiku: S-JTSK Krovak EastNorth (Layers > Properties > Qtinate System >
Projected Coordinate Systems > National Grid®oté byl pipojen vykres se
zametenymi body a liniemi fedstavujici pibéh Zlaté stezky ve formatu *DGN:
zlata_stezka.dgn (Add Datap formatem *DGN vSak nedokdze program ArcGIS
pracovat, proto bylo zap@eti fevést body a linie na vhodny format *SHPata >
Export Data) Vznikla tak nova bodova (point) 3D vrstvetezka_body.sha liniova
(polyline) 3D vrstvastezka_linie.shpNa prvni pohled se 3D vrstva nikterak nelisi od
2D, avSak po otdeni atributové tabulkyOpen Attribute Tabldze vidt u 3D
sloupecShape ve kterém jePoint ZM (bodova vrstva) neb@olyline ZM (liniova
vrstva). V tomto sloupci jsou ulozeny gadnice X, Y a Z, které jsou pro uzivatele
skryty, ale je mozné, kdykoliv je zobrazit pomokifigtu ve Field Calculator (Open
Attribute Table > Options)Fi prevodu *DGN na *SHP se s&adnice Z zobrazi
navic ve sloupcklevation. Déale jsou v atributové tabulce zobrazeny i dsiSipce,
které informuji nap o predchozim formatu *DGN nebo o nazvu vrstvy, ve které
byly zobrazeny bodyi linie v programu MicroStation. Tytorpbyt&né sloupce byly
odstragny pomoci funkceDelete Field (Open Attribute Table > Option§) tomto

okamziku byla fipravena nariena data pro tvorbu digitalniho modelu terénu.
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7.3.1TIN

Model TIN pracuje na bazi nepravidelné trojuhetvik si¢ (kap. 5.2.2). R
tvorbe TIN je mozné pouzit vektorove vrstvy vSech zakladrgeometrickych tyin

body, linie a polygony. U kazdého typu je nutnéituco gredstavuje (typ vstupu):

* Mass points — predstavuji body se znamou nadsiou vySkou a tvid

vrcholy budouciho TIN.

* Breaklines — jsouc¢ary ozngujici mista seietelnou zminou pibéhu terénu
(singularity). PouZzivaji se nagk vyznaeniiek, pat budov, udolnic, pbchu
valu ¢i navigace. Bezéthto Udaj je zpravidla model népsny. Téz Izéici,
Ze linie zadané jakBreaklinesse ve vysledku uplatji jako povinné hranice
trojuhelnik, tj. neprobih& fes r¢ interpolace a ponechavaji si svaiwpdni

hodnotu.

* Clip polygons — ohrantuji feSené Uzemi, tj. ohraiji interpolaci a definuji

prostorovy rozsah vysledného TIN.
» Erase polygons- ohrantuji tzemi, které bude z vysledku vymazano.
* Replace polygons- se pouzivaji pro definici plochych (vodorovnydizgmi.

» Tag value fill polygons — pifazuji trojuhelnikm uvnit polygoni
celatiselny atribut (naip kéd gredstavujici typ krajinného pokryvu. Tento
atribut mize byt pouzit i vizualizaci modelu (vysledné zobrazeni pak

evokuje terén potazeny dalSi vrstvou).

Kazdy z vyjmenovanych typvstupi kromé Mass pointamize byt definovan
jako Soft (mékky) nebo Hard (tvrdy) — nap. Breaklinesve skuténosti zadavame
jako SoftlinesneboHardlines Linie nebo hranice polygdndefinované jakdHard
piedstavuji retelné zlomy terénu (n&p naspy, hraze, udolniceSoft hranice
nenarusuji hladky gbéh terénu a nemaji geomorfologicky vyznami fejich
pouziti se na jejich mistvytvori hranice trojuhelnik, které vSak negdstavuji
terénni zminy. RiklademSofthranic mohou bytieba hranice okrésci jinych ¢asti

zajmového tzemi (Simova 2008).

Tvorba modelu TIN v programu ArcGIS ma dva krokytvoreni prazdného
modelu a jeho nasledna editace. Prazdny TIN sekiy@reate TIN (3D Analyst
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Tools > TIN Creation)a jako referetni systém se nastavi S-JTSK Krovak
EastNorth. FunkcEdit TIN (3D Analyst Tools > TIN Creatiorge spusti editace a
prakticky tvorba celého modelu. Zde je nutné nastravre vstupni hodnoty (typ
vstupu) a sloupec s nadis&ou vyskou. Bodové vrsistezka body.shipyl ptirazen
typ Mass pointsa liniové vrst¢ stezka_linie.shptyp Breaklines — Hardlines
Nadmdskou vysku bylo mozné st ze sloupceShapenebo Elevation Vznikly
model byl pro pehlednost ,éiznut* podle pedem definovaného polygonu funkci:
Clip polygonsv editaci TIN, rozdlen na fi ¢asti a vyexportovarfFile > Print).

Z modelu TIN Ize velmi snadno ziskat vrstevniceoafunkci TIN Contour (3D
Analyst Tools > TIN Surface)nterval vrstevnic byl nastaven na 1 m. Vrsteenic
vSak bylo nutné i@d vystupem ,vyhladit®. K tomu poslouzila funkc8mooth Line
(Data Managment Tools > Generalization)a nabizi d& moZznosti interpolace:
Peak — vyhlazené vrstevnice neprochazi vstupnimi bodeaier Interpolation—
vrstevnice vstupnimi body proch&zi. Pro vyhlazenstexnic byla nakonec pouZzita
metodaPeaks tolerancb. Takto upravené vrstevnice byly@pozdileny na fi ¢asti

a vyexportovany ve forgnvrstevnicoveho planu.
7.3.2 Rastrovy model

Rastrovy model byl vyty@n z givodniho modelu TIN a to interpalai
metodouNatural Neighbours(ptirozenych sousdd. Tato metoda je zaloZena na
principu Thiessenovych polygdnPolygony jsou vytvieny z bodové vrstvy tak, Zze
do kazdého polygonu spada jeden bod a vSechna pubtgonu jsou blize bodu,
ktery lezi uvnit ného, nez bodu jinému. Tato metoda je velice efektipokud jsou
nantiené hodnoty rozmi&ty pravidel. Metoda spéiva v odhadu neznamych
hodnot z ®kolika nejblizSich hodnot. Uzemi je nejprve réemho do nepravidelnych
trojuhelnika (tzv. Delaunay triangulace), z nichZz jsou nastediytvoreny tzv.

Thiessenovy polygony (Burian 2008).

Pro gevod TIN na rastrovy model slouzi funk@dN to Raster (3D Analyst
Tools > Conversion > From TIN)de byla nastavena jiz zn¢ima metodaNatural
Neighboursa velikost btiky (Cell siz na hodnotu 0,25. Pro realistické znazoin

vlastniho terénu v rastrovém modelu slouzi funkoetoHillShade(3D Analyst

40



Tools > Raster Surfacede se nastavuji dva parametAzimuth— nat@eni ke
swtové strad ve stupnich &ltitude — vySka nad obzorem. V tomtdipact byl
Azimuthnastaven n&815° a Altitude na50°. Vznikl tak novy rastrovy model, jehoz

vystup byl pro pehlednost rozélen na Xasti.
7.3.3 Porovnani presnosti

P¥i zamgrovani Uuseku Zlaté stezky byl zaran i okolni terén (kap. 7.1), ale
pro vizualizaci ¥tSiho modelu TIN a rastrového modelu se totdemi ukazalo jako
nedostaténé. Pro dalSi presentaci vyslédikbylo vhodné propojit zadieny usek
s vySkopisnymi daty ZABAGED® nebo s digitalnim mbaa reliéfu DMR 4G.
Predtim, vSak bylo zapmbi zjistit, jaké odchylky jsou mezi skdtgmi
(nametenymi) nadmiskymi vySkami a daty ZABAGED® resp. DMR 4G.

Pro porovnani nadniskych vysSek bylo fedem nutné upravit vstupni data.
Z nantienych hodnot byly odstrany body, které fedstavuji ,dno” stezky. Vznikla
tak nova bodova vrstvarysky.shp ktera representuje pouze horni hranu stezky a
okolni zamdteny terén. Déale byla vytvena nova polygonova vrstva
polygon_vyska.shpahrnujici pouze okolni terén a to nejen podétlst a mezi
jednotlivymi kolejemi stezky, ale i zaiteny terén ped z&atkem a po ukafeni
pribéhu stezky samotné.

Pro porovnani nadniskych vySek byly pouzity 2 metody. Prvni je vizuiahn
na zaklad rozdili dvou rastrovych modél Tato metoda zobrazi mista s rozdilnou
nadmdskou vySkou a ifbliznou hodnotu jejich rozdilu. Druha metoda je@mani
nadmdskych vySek konkrétnich bads hodnotami vzniklého modelu. Z rozdike
vytvorit graf cetnosti a dale pak stanovitrestini kvadratickou chybuRpot Mean

Square Error — RMSkEpodle vzorce:

| .'"':r
RMSE = \'%Z{MI}E
IN =1

kde Ah je rozdil skutené namdrené vysky a vysky ve stejném ndishodelu a N je
pocet kontrolnich bodl.
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Pro lepSi ndzornost je zde uveden postup provetemaci.

‘ Geodeticky ziskana data ‘

Vipodetv

Groms

‘ Seznam souradnic }—.

WVizualizace Vizualizace Interpolace
MicroStati AreGIS Natur. Neizhh
| 3D rastrovy model

Vizualizace Interpolace o
ZABAGED Paze il 3D rastrovy model ‘

Interpolace

Natmral Neighh

Porovn:ini piresnosti

Porovnani nam¥enych hodnot a ZABAGED®

Nejprve byl vytvden rastrovy model terénu z vysSkopisnych dat ZABAG@ED
— vrstevnic o intervalu 5 m. Pro tvorbu rastrovéadelu byla pouzita metodeopo
To Raster Tato specialni interpatai metoda je navrZzen& pro tvorbu hydrologicky
spravnych modél terénu. Zaklada se na programu ANUDEM (Kienzle 808 je
upravenim metodyspline (Burian 2008). Ke vzniku modelu se vyuZziva vrsievn
(Contoup. Do vypdaitu Ize dophkové zaadit i vySkové body, ndpvrcholy kopd
(PointElevation afadu singularit:

» Sream — Hydrograficka sl Muze vyrazg zlepSit kvalitu modelu. Rbéh

Streamma ve vypo6tu prioritu gred vrstevnicemi.

e Lake — Vodni plochy, obeenzcela plocha mista v modelu. iiky v lokalité

vodni plochy dostanou hodnotu minima petnicary (okraje).

* Sink — Znadmé terénni deprese, skui& bezodtokové oblasti. V depresi musi
byt zndma vyska, ktera se udava jako parafield. Hodnota se zahrne do
vypoctu, ¢imz se model zZgsni. Rikladem mohou bytiéba zavrty na

krasové plania
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* Boundary — Hranice vystupu. VSechny fiky vystupniho rastru, které se
ocitnou mimo polygon igdstavujici hranici, budodNoData Tj. miZzeme
vystup Fimo nastavenim vygtu ofiznout podle hranic daké zgjmove
lokality (Simové 2008).

Rastrovy model terénu vznikl funkdiopo To Raste(3D Analyst Tools >
Raster Interpolation)kdy vstupem byly vrstevnice ZABAGED® jako tyfontoura
piedem vytvéeny polygonzajmove_uzemi.shjako typ Boundary Tento polygon
zahrnoval nejblizSi okoli vSech zaranych bod a fungoval jako hranice vystupu.
Digitalni model se tak netvib ze vSech vrstevnic, ale pouze z vrstevnic uvnit

polygonu. Velikost biiky rastru (@Il sizg byla nastavena na 0,25.

S pomoci funkcdextract by Mask (Spatial Analyst Tools > Extrachidoyl
postupr ,vytiznut* pro kontrolu pesnostivyska polygon.shp rastrového modelu
(vytvoieného z TIN) a z rastrového modelu (ZABAGED®). Ndst byly tyto dva
rastry od sebe odteny funkci:Minus (3D Analyst Tools > Raster Math).

Pro druhou metodu kontrolyrgsnosti nadmiskych vySek byl vyuZit nay
vytvoreny rastrovy model terénu z vrstevnic ZABAGED® amiigenych bod
vysky.shpFunkci:Interpolate Shapé€3D Analyst Tools > Functional Surfackyly
vyexportovany body z rastru, které jsou identickéastienymi body vysky.shp
Vznikla tak nova bodova vrstvalN_ZABAGED.shpV atributové tabulce byla
zobrazena nadniiska vySka rérenych bod (sloupecElevatior). Nadmdska vysSka
ZABAGED® byla skryta ve sloupcShape(kap. 8.3). Pro jeji zobrazeni bylo
zapotebi vytvadit novy sloupecAdd Field a pomoci skriptu vé-ield Calculator

vyexportovat: Dim Output As Double

Dim pPoint As IPoint

Set pPoint = [Shape]

Output = pPoint.Z
kde pPoint.Zpfedstavuje nadniskou vySku (sotadnici Z). Analogicky lze takto
vyexportovat i sotadnice X a Y. Poté byl @&p vytvoien novy sloupe@dd Fielda

v ném ve Field Calculator doSlo k odéteni vySky narérfené a nadmigké vysky

ZABAGED®. Vyhodou funkcd-iel Calculatorje ta, Ze vypeet je proveden pro
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cely sloupec pap pouze pro ozri@na data. Z vypienych rozdii byl vytvoren graf
cetnosti a spitana stedni kvadraticka chyba RMSE.

Graf éetnosti rozdild

tetnost

425 375 -325 275 225 175125 075 025 425 075 125 175 225 275 325 3,75
rozdil nadmorskich wsek [m]

Obr. 7.1 Grafcetnosti rozdit nadmdaskych vySek - ZABAGED
min. =-4,32 m max. = 3,52 m pimér = 0,35 m RMSE =1,42 m

Porovnani nay*enych hodnot a DMR 4G

Rastrovy model terénu byl vytien interpolaciNatural Neighbours(3D
Analyst Tools > Raster Interpolation)velikosti buiky (Cell size)0,25. Cely postup
byl prakticky stejny jako u rastrového modelu ZABBB®. tj. vytriznuti kontrolnich
polygon vrstvouvyska_polygon.sha jejich nasledné odeni od néfenych hodnot
funkce: Minus (3D Analyst Tools > Raster Math)A poté i druhy zpisob kontroly
piesnosti nadmgkych vySek, kdy vznikla nova bodova vrstVéiN_ DMR.shp ve
které byly zjiS&ny rozdily nadmieskych vySek a nasledrvytvoren grafcetnosti

téchto rozdili spol&né s vypatem stedni kvadratické chyby.
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Graf éetnosti rozdilu
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rozdil nadmofskych vigek [m]
Obr. 7.2 Graf¢etnosti rozdit nadmdskych vySek — DMR 4G
min. =-2,07 m max. = 2,02 m pmér=-0,19m RMSE=0,43m

Vliv rozliSeni beky rastru na kvalitu fesnosti

Veskeré rastrové DMT byly vytwveny s velikosti biky 0,25 ve snaze o co
nejwtsi moznou fesnost. AvSak nevyhodou vysokého rozliSeni je akév
mnoZstvi dat, vySSi naroky na hardware a softwateké delSi doba zpracovani
vysledki. Proto byl dale zkouman vliv velkosti itky na gesnost vytvéenych

rastrovych modél za &elem nizSiho objemu dat.

Postups byly vytvoreny rastrové modely terénu o rozliSeni: 0,25 —0150
— 2,0 — 5,0. Pro data ZABAGED® byla @ppouzita funkceTopo To Raste(3D
Analyst Tools > Raster Interpolatiom pro DMR 4G interpokai metodaNatural
Neighbours(3D Analyst Tools > Raster InterpolationNove vzniklé rastry byly
porovnavany s bodovou vrstvou n&enych nadmiskych vysSek a byla proén

spaitdna stedni kvadraticka chyba.

45



Rozdil netenych vysek a ZABAGED

Velikost bunky 0,25 0,5 1,0 2,0 5,0
Velikostdat | 53,96 MB| 13,49 MB| 3,38 MB| 866,53 kB 139,90 kB
Min [m] - 4,32 -4,31 -4,29 -4,29 -3,96
Max [m] 3,52 3,53 3,54 3,63 3,53
Pramér [m] 0,35 0,35 0,35 0,35 0,38
RMSE [m] 1,42 1,42 1,43 1,44 1,42

Tab. 7.1 Kontrola pesnosti — ZABAGED

Rozdil netenych vySek a DMR 4G

Velikost buiiky | 0,25 0,5 1,0 2,0 5,0
Velikostdat | 53,48 MB | 13,38 MB| 3,35 MB| 860,23 kB 138,36 KB
Min [m] - 2,07 - 2,07 - 2,07 - 2,07 - 2,07
Max [m] 2,02 2,02 2,02 2,02 2,02
Pramér [m] - 0,19 - 0,19 - 0,19 - 0,19 - 0,19
RMSE [m] 0,43 0,43 0,43 0,43 0,43

Tab. 7.2 Kontrola gesnosti — DMR 4G

Navzdory pedpokladm o klesajici kvalit pii zmenSovani rozliSeni rastru,
z uvedenych hodnot vyplyvda, Z& pnizovani rozliSeni se kvalita rastrového modelu
pro dané Gzemi t&h nentni. Dale je patrné, Ze pro tvorbu rozsahlejSiho ehod
terénu jsou nejvhodysi data DMR 4G.

7.3.4Vizualizace terénu

Jak jiz bylo zmigno, pro tvorbu ¥tSiho modelu terénu zahrnujici SirSi okoli
zantieného Useku Zlaté stezky, byla vybrana vyskopista BMR 4G. Nyni bylo
zapotebi vhodnou interpotai metodou propojit tato data s n&menymi hodnotami.
Jako nejvhod§si interpolace byla vybrana geostatistickd metéamying, ktera
provadi vypdet neznamé hodnoty pomoci vazenéhangru. Vahy jsou uteny
podle prostorové variability a poskytuji tak optimiainterpolaci s minimalnimi
odchylkami (Desmet 1997Kriging vytvoril Georges Matheron na zakkagrace
Daniela G. Krige jiz v roce 196Kriging je vypaitové jedna z nejslozifSich aradi
se mezi exaktni interpalai metody. Pouziva se zejména pro geologické amika
nékdy se vSak hodi také pro interpolaci vySek nebdeorelogickych dat (Burian
2008).

Pro tvorbu rozsahlejSiho modelweného k presentaci a 3D vizualizaci bylo
zapotebi gipravit si vstupni data. Byl vytwen polygonctvercového tvaru o rozloze
1,44 knf, piedstavujici hranici zajmového Gzemi. Podle tohotdygonu byla
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ofiznuta data funkcClip (Analysis Tools > Extracty DMR 4G a vznikla tak nova
bodova vrstvacuzk.shp Déle bylo podle tohoto polygondinnuto orotofoto funkci
Extract by Mask (Spatial Analyst Tools > ExtracfioDalSimi nezbytnymi daty byla

bodova vrstvatezka_body.shfiniova vrstvastezka_line.shp

Po zapnuti funkc&riging (Geostatistical Analyst > Geostatistical X&lrd),
byla nastavena jako vstupni vrststgzka body.shpgPoté byl vybran druKriging —
Ordinary, ktery se pouziva, pokud se v datech nevyskytliyejimého faktoru a typ
semivariogramuSpherical Vznikla tzv. Geostatistical Analyst Layejejiz hodnoty
byly naimporotvany funkcGA Layer To Points (Geostatitistical Analyst Toals)
bodové vrstvycuzk.shpa vznikla nova vrstvabody_tin.shp Nasledovala tvorba
modelu TIN novy_tin (kap. 8.3.1), kdy vstupnimi hodnotami byla towznikla
bodova vrstvabody tin.shpa stezka_linie.shp Z tohoto modelu byly nasledn
vyexportovany vrstevnice funkdiN Contour (3D Analyst Tools > TIN Surface)
sintervalem 2 m. Tyto vrstevnice byly &p funkci Smooth Line (Data
ManagementTools > GeneralizatiometodouPeak 5vyhlazeny do konaé podoby

vrstevnice.shp

Pro vlastni 3D vizualizace slouZi nadstavba Arc8cé&tera svym proidim
pfipomin& ArcMap, pouze stim rozdilem, Ze zde nelyworit klasicky layout
(vystup). Nenachazi se zde tak moznost zobrazeiitka, @ipojeni legendyci
severky. Vyhodou této aplikace je prostorové zodmazredmeta z miznych uhti a
stran. Ripojeny model TIN Add Datg ma automaticky ifirazenou nadmniskou
vySku. Pro lepSi vizualizaci a znazémh vyskovych rozdil byla nastavena konstanta
Custom(Properties > Base Heighst)a hodnotu 2. Dale bylaipojena vrstva/Add
Data) stezka_linie.shpvrstevnice.shpa aiznuté ortofoto. ¥mto vrstvam bylo
potreba spoléné s konstantouCustom2 piifadit také nadmigké vysky z modelu
TIN (Properties > Base Heighst)Mystupem se stal 3D vrstevnicovy model a 3D
model, jehoZz povrch byl znazam orotofotem. Zdchto model byla nasled&

vytvoiena animace.
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8 Vysledky

Prvnim vysledkem diplomové prace je bezpochybydgaoké zamsreni
souasného stavu Useku Zlaté stezky a naslednd tveesagho digitalniho modelu
terénu metodou TIN. Tento model byl vytea bez jakychkoliv Gprav a vyhlazeni
hran. Z modelu TIN byly nasledrvyexportovany vrstevnice s intervalem 1 m pro

tvorbu vrstevnicového planudteného tzemi.

Poté byl model TIN f@veden na rastrovy model. Bylo to jednakizatiu
vytvoieni realistitéjSiho zobrazeni daného Uzemi pomoci furidkshade (osvit) a
z davodu pozdjSi analyzy — kontroly fesnosti vySkopisu.

DalSim vysledkem je porovnanfgsnosti zrtenych nadmiskych vysek s
vySkopisem ZABAGED® a DMR 4G.#Ptéto analyze bylo zji§ho, Ze pestoze
pramérny rozdil nadmiskych vySek rrenych hodnot a ZABAGED® je +0,35 m
(+0,38 m pro velikost hiky rastru = 5), rozptyléchto rozditi je zn&né velky a
kolisa od +3,63 m do -4,32 m. Tato chyba jésgibena mé&hpiresnym vyskopisem
ZABAGED®, neba’ ten byl odvozen z map ZM10, kde vrstevnice v lespbrostu
a na prudSich svazich jsou vintervalu 5 m. Vellogptyl rozdii vySek a
nepravidelné stdani jejich kladnych a zapornych hodnot #emém Useku, snizilo
moznost dalSiho vyuziti vySkopisnych dat ZABAGEDR¥ porovnani ndfenych
vySek a DMR 4G byl zjigh primérny rozdil -0,19 m (-0,18 m pro velikost iky
rastru = 5). Déle bylo zji&ho, Ze rozptyl rozdil neni zavisly na velikosti kiky
rastru a pohybuje se od +2,02 m do -2,07 m. Sfeko u dat ZABAGED® dochazi
k nepravidelnému gtani hodnot rozdil nadmdskych vySek, ale rozptyl aistni
kvadraticka chyba byla nizsi nez u ZABAGED®, prbiga data DMR 4G vyuzita
pro tvorbu komplexgSiho modelu terénu.

Poslednim vystupem se tak stal rozsahlejSi 3D hted&nu zahrnujici i SirSi
okoli. Fredtim bylo vSak nutné vzajempropojit nangrena data s DMR 4G. Nejprve
byly zmeéfené body interpolovany geostatistickou metodou iHgga poté
importovany k DMR 4G. Z&hto spolénych dat byl vytvéen novy model TIN, ze
kterého byly naslednvyexportovany vrstevnice. Vysledkem se stal pnastp 3D

model terénu zobrazeny v nadstayrcScene vetn® animace.
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9 Diskuse

Pouzité metody tvorby digitalniho modelu terénu mrdoho vyhod, ale také

sva omezeni. V této kapitole bych r&tbpzil n¢které z nich.
9.1 Vstupni data

Geodetické zasiteni vterénu je sice ndgsrEjSi zpisob ziskani dat pro
DTM, ale je velice caso¥ a finakné narané. DalSi nevyhodou je vyuZziti
geodetického gieni pouze pro mensi Uzemfi ®orbé DMT vétSich celki, kterymi
se v minulosti zabyvaly ve své praci KartografickZualizace a tvorba digitalniho
modelu terénu okoli hradu VetgHaSova 2009§i Kartograficka 3D vizualizace
okresu FPerov (Stilkova 2012), je ziskavani datipym mefenim v terénu naprosto
nevhodné. Pro takovéato velka Uzemi je dobré vywEkopisnych dat ZABAGED®
spravovanych CUZK ¢ vojenského digitdiniho modelu Gzemi (DMU 25).
V sowtasné dob se dokotuje UpIné pokrytiCeské republiky DMR 4. G, ktery ma
tvar pravidelné sit bodi 5x5 m. V roce 2015 seigdpoklada uplné pokry@€R
digitdlnim modelem reliéfu 5. generace (DMR 5GEritma tvar nepravidelné &it
bodi (TIN) se stedni chybou vy3ky 0,18 m v odkrytém terénu a 0,% tarénu
zalesgném CUZK 2013).

9.2 Tvorba DMT

Vysledny model terénu neoviivje pouze kvalita vstupnich vySkopisnych
dat, ale také vy vhodnych interpoknich metod fi tvorbé DMT. Burian (2008) ve
svem¢lanku popisuje moznosti vyuzithiznych typi interpolaci pro konkrétnicély.
Zavislosti interpolénich metod na kvalitu DMT se zabyval napesmet (1997),
ktery zkoumal vhodné interpolace pro mala rovinaémi v Belgii (do 3 — 4 ha),
kde se jevila jako nejvhodj$i interpol&ni metodeSpline

V této praci bylo o¥ieno, Ze pro tvorbu DMT z vrstevnic je nejvhédn
metodaTopo To RasterNaopak pro vytvieni DMT z pravidelné sitbodi je
nejlepsi pouzit interpotai metoduNatural NeighboursPro propojeni nadéienych
dat a vySkopisu DMR 4G se askila geostatistickd metodiriging. Je to velice
piesna interpokini metoda, nelib neznamé hodnoty vypitdva podle vazeného

praméru. Nevyhodou této metody je velmi slozity vyeb.

49



9.3 Porovnéani presnosti DMT

P¥i posuzovani fesnosti DMT byly porovnavany nejen zdroje dat, ialév
velikosti buiky na kvalitu vysledného rastrového DMTi Porovnavani nagtenych
dat s daty £UZK, bylo zji$&no, Ze nejmensi rozdily jsoti pouZiti DMR 4G. Jak
bylo jiz receno, kvalita vySkopisu ZABAGED® je snizena #wddu pevzatych
vrstevnic z map ZM10 o intervalu 5 m.

Podobnou analyzuigsnosti provedli Janec, #0(2004), kt¢i srovnavali
presnost vojenského digitalniho modelu reliéfu (DM&)digitalniho vySkového
modelu (DEM) vytvdeného z dat druzice SPOT a jejich pouzitelnosti tposbu
ortofota, kdy zjistili, Ze DMR nelze vzhledem k spi@snosti vySkopisu vyuZzit jako
podklad map r&itek wtSich nez 1:50 000, u DEM je tato hranice pouZzasinaz od
metitka 1:500 000. festo Ize DEM pouzit n@ppro mapovani nedostupnych oblasti,
kdy je tato pesnost dostatea.

Jak bylo zji&no, velikost biiky rastru na fesnost vyskopisu neifta
prakticky zadny vliv. Je to Zigsobeno pedevsim velikostfeSeného tzemi. Pokud by
bylo zajmoveé Uzemidisi, jis€ by se tento faktor projevil. Podle Kienzle (20048,
pro Gzemi cca 15 kfrs prongnlivym sklonem nejvhod$si velikost buiky 5 — 20 m.
Tato analyza byla provéda v Kanad ve st& Alberta. Kde byla zkoumana 4an¢

élenita tzemi.
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10 Zavér

Cilem této diplomové prace bylo vyhotoveni geark&ti a prostorové
dokumentace Useku Zlaté stezky za pouziti ndst@jS a porovnat vyhotovené

modely terénu ohledjejich representativni schopnostii@gnosti.

Potvrdilo se, Ze pozemniédieni, jakozto ziskavani dat pro tvorbu DMT, je
v souwtasné dob sice stale nejesrjsi, ale zarovie nejnar@néjSi metodou, & po
strance finatni neboc¢asové. Dale bylo zji8ho, Ze pro tvorbu i@gsného DMT
zantieného Useku Zlaté stezky je sice vhodny model Téha vstupem jsou
métena data bez jakychkoliv Uprav, avSak pro re&tig§i ztvareni terénu je lepsi
pouzit model rastrovy.iPporovnavani pesnosti jednotlivych DMT s natifenymi

daty, byla potvrzena dominka o horsi kvalit vySkopisu ZABAGED®.

Vysledna vizualizace Uzemi pomoci 3D modelu, ktemnikl spojenim
namérenych dat a DMR 4G, je ko&reym vystupem této diplomové prace. Timto
zpusobem lIze presentovat jakékoliv Uzethibbjekt na Zemi. V satasnosti se 3D
modely Gzemi velicéasto pouzivaji nappri presentaci urbanistickych studiich, kdy
si i kazdy dokaze ipdstavit rozmighi zastavby lépe neZlifippouhém pohledu na

plan.
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